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This presentation will cover migrating to WebSphere Process Server V6.0 from
WebSphere MQ Workflow

WPSWIDv6_MQWF_Migration.ppt Page 1 of 54



| IBM Software Group

Goals
€

= Detailed discussion of the
migration utilities for
WebSphere MQ Workflow

»  WMQWF 3.5 and 3.6 \_-3$
WebSphere MQ Workflow

WebSphere
Process Server V6

WebSphere MQ Workflow Migration © 2005 IBM Corporation

WebSphere Process Server is the merger of 3 existing product lines.
*WebSphere InterChange Server
*WebSphere MQ Workflow

*WebSphere Business Integration Server Foundation

This presentation will discuss the details of migrating from WebSphere MQ Workflow.
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Agenda

= Introduction

= Overview

= Migration

= Mappings from FDL to BPEL

= Limitations

WebSphere MQ Workflow Migration © 2005 IBM Corporation

The agenda for this presentation is to focus on the steps involved in migrating from
WebSphere MQ Workflow to WebSphere Process Server V6.

It begins with an introduction of background material and tasks that should be done before
starting a migration effort.

Followed by a high level overview of the migration process.

Migration options and details will then be discussed with detailed information about the
artifact mapping from WMQWF to WPS/SCA

Concluding with a section on the known limitations and how they impact the migration
process.
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Introduction - Before You Begin

= The mapping between WMQWF and the WPS SCA
programming model is not a perfect fit.

» There are limitations and workarounds which will require additional
work in order to complete the source artifact migration process.

= Before you begin:

» Read the Migration Guide that is available in the WebSphere
Business Process Integration InfoCenter

» Review the WMQWF best practices.
» Upgrade to WID/WPS 6.0.1

» Become familiar with the new WebSphere Process Server SCA
programming model by doing tutorials and exercises.

WebSphere MQ Workflow Migration © 2005 IBM Corporation

Before you begin a migration, you should become familiar with the known limitations
identified at the end of this presentation and be prepared to perform some post migration
tasks.

You should also:

Read the Migration Guide.

Review the Best Practice for WMQWF development
Upgrade to WID/WPS 6.0.1

Become familiar with the SCA programming model
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Best Practices for WMQWF Development

= Best Practices to use when building WMQWF-based workflow
applications.:

= Runtime clients: Use the browser based web client of WMQWF. Neither
use the standard, ActiveX- based Windows™ runtime client nor
implement a custom runtime client by using the C, C++ or ActiveX API.

= Human-facing activity implementations: Use/customize the JSP-based
Web Client to implement JSPs for activities related to users. Do not use
the PEA for such activities.

= Automatic activity implementations:
= On all platforms: Use UPES based implementations.
= On distributed platforms: Do not use the PEA.

= On z/OS®: Invoke legacy IMS/CICS® applications via the PES
invocation mechanism and PES data mapping. Do not use the PES
container API for such activities.

= API: Only use the Java™ API

WebSphere MQ Workflow Migration © 2005 IBM Corporation

The best practices listed here have been published for current WMQWF development as

guidelines for mitigating potential problems when migrating to WPS V6.

It is recommended that you take a moment to review these ‘best practices’.
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= Information Center

Introduction - References

http://publib.boulder.ibm.com/infocenter/dmndhelp/v6rxmx/index.jsp

Contents Wy B

@ Websphere Process Server for Multiplal

L1 Installing and migrating to WebSphere Integ
[ working with modules and libraries
[ creating and mapping business objects

@ Rational Software Development Platf}
L Introduction to WebSphere Integration Dew

& ibm.com: About IBM - Privacy - Contact 2

2z

Select the
book for WID

Installing and
migrating

Installing WebSphere
Integration Developer

Iigrating applications

Then on the
right, select
the topic
migrating
applications

WebSphere MQ Workflow Migration
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The Information Center is an excellent place to get additional details about the migration

process.

A PDF version of the migration guide is also available from the Welcome Page of
WebSphere Integration Developer V6.
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Overview of the Migration Process

export FDL deploy EAR

(deep) ‘

Import WMQWF
FDL file

or
use WID Migration
Wizard

WebSphere WebSphere WebSphere
MQ WF Integration Developer Process Server
(Buildtime) (WID) (WPS)

WebSphere MQ Workflow Migration © 2005 IBM Corporation

From a high level perspective, the migration process consists of the following steps:

export from the source system, import to the target system, edit, resolve errors and tune
the migrated artifacts for BPEL / SCA and then deploy the application to the WPS V6
runtime.

Beginning with the Export:
*Export the FDL from the WMQWF environment using the WMQWF Buildtime Tool.

*This requires a semantically complete FDL
That is to say use, Export DEEP from the MQWF Buildtime

«Import the FDL into WebSphere Integration Developer V6 (WID) using the Migration
Wizard or File Import

*In WID, fix the Business Processes to eliminate any errors based on the errors identified
and the known limitations.

*Export the EAR and deploy it to the WebSphere Process Server V6 runtime (WPS)

The WID Migration Wizard will call the import utility under the covers which in turn will call
the import utility, which will call the FDL2BPEL utility.

The FDL2BPEL utility will generate the new artifacts which will be loaded into the
appropriate WPS modules.
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Using the WID Migration Wizard

= From the Welcome page, click the migration icon to open
the Migration page. >

= From the Migration page, select the
“Migrate a WebSphere MQ Workflow process” option.

Migration
Wizard

Migration
Guide

WebSphere MQ Workflow Migration © 2005 IBM Corporation

Using the Migration Wizard that comes with WID V6 is the easiest way to get started. The
Migration Wizard is launched from the Welcome page. To locate the Welcome screen in
WebSphere Integration Developer, use the menu bar, Help > Welcome.

The Migration Guide as well as the WMQWF Migration Wizard are available from the
Migration page.
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Using Import

= You can also open the Migration wizard from the WID
“Business Integration Perspective” by clicking:

= > File > Import > WebSphere MQ Workflow FDL file

4+ Import

Select

WebSphera MQ Workflow Migration

x|

=4

Select an import source:

ZHTTP
(T Interface/WSDL File
() J2EE Utility Jar
=, ISP Tag Library

, Project Interchange
@, RAR file
&, Server Configuration

[~ |

-

The Import function can also be used directly to invoke the Migration Wizard.

WebSphere MQ Workflow Migration

© 2005 IBM Corporation

WID V6 has a special import type for the WMQWF FDL file that will recognize the

WMQWEF artifacts and launch the Migration Wizard, which will convert them to the
appropriate WPS / BPEL artifacts as they are imported.
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Overview — alternative process

This alternative process is useful for debugging problems
encountered with the migration wizard.

FDL2BPEL
( command line utility )

o ||| )

export FDL

export EAR

WPS V6
artifacts

Import
WMQWF

FDL and WebSphere

W&%S\?Vhsre generated Integration Developer
WID
(Buildtime) i ( )
artifacts

WebSphere MQ Workflow Migration © 2005 IBM Corporation

Alternatively, you can download the WMQWF support pak WA73, which contains
additional documentation and the FDL2BPEL utility.

Using the FDL2BPEL utility directly from the command line with the FDL as input, the new
source artifacts can be generated and then imported into the appropriate WPS V6
modules.

Introducing this extra step can be useful when problems are encountered using the WID
migration utility, as the error reporting is more extensive with the command line tool.
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Download support pak WA73
Documentation and FDL2BPEL

Run the FDL2BPEL utility from the command line,
using the exported FDL file as input.

<+ Command Prompt

D:\FDL2BPEL_TEST\NiceJourney>fdl2bpel -oe MyMigrationProject -i NiceJourney.fdl

D:\FDL2BPEL_TEST\NiceJourney>"java" -classpath "D:\Diamond\Migration\FDL2BPEL-Converter\Toolf

nMigrationInterface.jar;D:\Diamond\Migration\FDL2BPEL-Converter\Tools\Uersion2.00\bpecore. ja
CUWBMOBEBI: FDL2BPEL converter version 2.00.

CUWBMOBOTI: Reading FDL input file "D:\FDL2BPEL_TEST\NiceJourney\NiceJourney.fdl".
CWWBMOB18I: Converting FDL name “Default Data Structure” to BPEL name "DefaultDataStructure”,
CWWBMOB18I: Converting FDL name “price” to BPEL name "Price™.

CWWBMOB18I: Converting FDL name “flightNumber™ to BPEL name "FlightNumber™.

FII IIIIIIIII ﬁl :‘ng*. . :L;§§§§ 11

The FDL2BPEL command line utility can be downloaded from the IBM Support site. The
URL is available in the references section at the end of this presentation.

Using the FDL2BPEL command line utility provides more control and error reporting,
which is beneficial when debugging migration problems.
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Using FDL2BPEL: Create a New Module

= From the Business Integration

Perspective, create a new |
Module

module G 1o s vt e At 4 v s T

» File > New ->Project > Module

Module

» make the module name the same st
as the Value used for the Command Directory: [ D:\WID601_Workspaces\FDLZBPEL\MyMigrationProject BroviEE, .,

line parameter, -oe —
Business integration modules can be deployed and run on WebSphere Process Server.
They can contain many types of components, such as business processes, assembled
together for the purpose of business integration.

= Back Iext = | Finish I Cancel

© 2005 IBM Corporation

WebSphere MQ Workflow Migration

After the new artifacts have been generated using the FDL2BPEL utility, the destination
module must be manually created in the target workspace.

Making the module name the same as the name used when generating the artifacts will
reduce the amount of post migration rework.
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Using FDL2BPEL: Import the Generated

Artifacts ﬂ
= From the Resources r—
Perspective, Select the Import resources from the local file system.

project folder and import the s eearemons
generated files.

» File > Import > File System

~IREREEEEEE

Filter Types... | Select All Deselect All

Tnto folder: | MyMigrationProject Browise...

ptions:
I~ Ovenwrite existing resources without warning
" Create complete folder structure

@ Create selected folders only

< Back nos [ Fnish cancel

WebSphere MQ Workflow Migration © 2005 IBM Corporation

The next step is to import the generated artifacts into the newly created module and
workspace.
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Using FDL2BPEL

= For technical background use the documentation
that comes with WMQWF support pac WA73

» The FDL2BPEL Conversion tool

= The Command line tool also lets you select
between migration to WBI SF 5.1.1 and WPS 6.0.1
(parameter “v”)

= The wiring of the SCA module is not done
automatically.

= Provides more control over the migration process.

14
© 2005 IBM Corporation

WebSphere MQ Workflow Migration

The WMQWEF support pac WA73 is provided to support WMQWF users and is from the
perspective of WMQWF.

The documentation that is provided with the support pak is more complete than that
available in WPS V6 Information Center and will provide the technical background that will
be familiar to WMQWF users.

Note that the wiring of the module assembly will be part of the post migration work.
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The Post Migration Fixup Step

= The existing artifacts have been imported into WID,
the next step is to resolve all the errors and
implement workarounds for the limitations.

= This next section on Mapping FDL to BPEL is to
lay the groundwork for completing the fixup.

» It provides the understanding for all the new artifacts that
have been generated.

= The subsequent section will discuss the limitations.

» Understanding the limitations will provide the information
necessary for implementing any workarounds that may be
necessary.

15
© 2005 IBM Corporation

WebSphere MQ Workflow Migration

At this point all of the WMQWF artifacts that can be converted, have been converted to
WPS V6 BPEL / SCA artifacts.

However, not all artifacts can be converted and there will be errors to correct and
workarounds to implement.

The remaining part of this presentation will focus on what does get mapped and then
highlight the limitations.

This will provide the information needed to complete the migration so that the application
can be deployed to the WPS V6 runtime.
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Mapping FDL to BPEL

WebSphere MQ Workflow Migration © 2005 IBM Corporation

This section will cover the mapping of Flow Definition Language (FDL) to Business
Process Execution Language (BPEL).
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Mapping FDL to BPEL with Extensions

= Data

= Interfaces
= Activities
= Data Flow

= Control Flow

WebSphere MQ Workflow Migration © 2005 IBM Corporation

Each category listed here represents a kind of FDL artifact that must be considered when
migrating from FDL to BPEL.
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FDL to BPEL Mapping: Data

= Data

WMQWEF Process Model Construct | BPEL with Extensions Construct

Data structure Business data (specified by
XMLSchema definition)

Input / output container of activity Variables (used to specify the
input/output of invoke activity)

Global data container Variable

WebSphere MQ Workflow Migration © 2005 IBM Corporation

In BPEL / SCA, data are represent by XML Schema and XSDs and variables are used to
hold the data values and facilitate the movement of data from one activity to another.

The WMQWEF data container can be mapped directly to the BPEL variables.
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FDL to BPEL Mapping: Interface

= Interface

WMQWEF Process Model Construct | BPEL with Extensions Construct

Process invocation Partner links

Process interaction with other
programs and/or processes

Source and Sink Receive and Reply activities with
Variables assigned to process input /
output

WebSphere MQ Workflow Migration © 2005 IBM Corporation

With BPEL, the interfaces are defined using WSDL, which in turn defines interactions with
other services in terms of Partner Links.

With WMQWEF, the external interface to the business process is called a Source and the
external interface for the output is call the Sink. BPEL provides analogous constructs
called Receive for input and Reply for output. Its very natural to map the Source to the
Receive and the Sink to the Reply.
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FDL to BPEL Mapping: Activities

= Activities

WMQWF Process Model Construct | BPEL with Extensions Construct
Program activity Invoke activity

(invoke service or human task)
Process activity Invoke activity

(invoke partner process)
Empty activity Empty activity

(point of synchronization)
Block activity Scope (vertical flow structure)

WebSphere MQ Workflow Migration © 2005 IBM Corporation

For each of the four basic activities in WMQWF there are corresponding constructs in
BPEL. The mapping is relatively straightforward based on classification rules, which will be
discussed in subsequent slides.
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FDL to BPEL Mapping: Data Flow

= Data Flow
WMQWF Process Model BPEL with Extensions
Construct Construct
Data connector Assign activity
(copy data between variables)

WebSphere MQ Workflow Migration

© 2005 IBM Corporation

Data flow is one of those constructs in WMQWF for which there is no analog in BPEL. The
movement of data in BPEL is managed by assigning data to variables, which are then
used by the activities. When a data connector is encountered in the WMQWF model,
Assign activities are created and inserted into the BPEL model at the appropriate places.

An example is provided later in this presentation.

WPSWIDv6_MQWF_Migration.ppt
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FDL to BPEL Mapping: Control Flow - structure

= Control Flow (structure)

WMQWF Process Model Construct | BPEL with Extensions Construct

Process with assigned activities Process

Flow (concurrent activities)
Sequence (of activities)
While (repeated activity)

Control connector Link (dependency between two
activities)
Staff assignment Staff verb set (specifying potential

owners of “Inline Human Task”)

WebSphere MQ Workflow Migration © 2005 IBM Corporation

There are two aspects to control flow, one is structure and the other is execution. When
considering the structural aspect of control flow in a WMQWF business process, there
are elements such as assigned activities, connectors and staff assignments.

WMQWEF provides only one basic kind of process and there are no ‘structuring’ elements
like the ones available in BPEL. With BPEL, there is the “Flow”, which allows for grouping
activities that will be run concurrently in a collapsible container with a distinct scope.
There is also the “Sequence”, which provides a collapsible container for activities that will
run sequentially.

The “while” construct is another feature that BPEL handles differently than WMQWF. The
“while” construct provides a way of grouping activities that will be run repeatedly while
waiting for some condition to be met. WMQWF has a more generic approach, using a
condition on the activity.

Therefore, based on the properties of the WMQWF activity, a BPEL Flow, Sequence or
While will be created.

The Link is the BPEL way of connecting two or more activities and the management of the
Staff assignment is done in the Verb of the Human Task activity.
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FDL to BPEL Mapping: Control Flow - execution

Control Flow (execution)

WMQWEF Process Model
Construct

BPEL with Extensions
Construct

Transition condition

Transition condition (of link
element)

Start condition of activity

Join condition (synchronizes
link targets)

Exit condition of activity

Condition (controls a While
activity)

WebSphere MQ Workflow Migration

© 2005 IBM Corporation

WMQWF uses conditions, which are checked to determine when to start, exit or transition
from an activity for controlling the flow of the business process. There is a corresponding
condition or construct for each of these in the BPEL model.

WPSWIDv6_MQWF_Migration.ppt
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Mapping FDL Data Containers to XMLSchema

WebSphere MQ Workflow Business Process Choreographer
Member [Type |
i LONG
- _PROCESS STRING
- _PROCESS_MODEL STRING
- _ACTIVITY STRING
#_PROCESS_INFO e
- ACTIVITY _INFQ i —— - }
TraveRequest | | anredeard I
CreditCard | [
STRING II \ [
Lahis ‘ I
| STRIMNG } I
L Cardsuccess STRING I P e | ‘
- Customer Customer ‘
#-FightReservation FlightReservation | }
#-HotelReservation HotelReservation | |
#-RentalCarFeservation  |RentalCarReservation | |
TraveRookinglD STRING | |
L \

WebSphere MQ Workflow Migration © 2005 IBM Corporation

Mapping of the data structures from WMQWF to WPS/BPEL is very straightforward. In
WMQWEF the data are defined as structures and in WPS/BPEL data are defined using
XML Schema and XSD. Both systems provide for complex nested structures, which
makes the mapping intuitive.
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Mapping FDL source / sink to BPEL “Receive / Reply” activities

WebSphere MQ Workflow Business Process Choreographer
@
Z Sequence
\ ’ / I L
\"P“, R \_@ Receive_’ -
\w N ~SourceAndSlnk IN B MyActhlty IN -

MyActivity

___————__

\.:. MyAct|V|ty OUT" -> "SourceAndSink_f OUT

AR o
P TR L W ‘ ? r:ply:’
A ==
\\_// ®

WebSphere MQ Workflow Migration © 2005 IBM Corporation

The WMQWEF concept of source and sink map nicely to the BPEL receive/reply activities.
Because there is no explicit data flow in the BPEL model, the Assign activities are
inserted in the BPEL model to facilitate the movement of data into and out of the
activity.

The graphic above illustrates:

1) How the WMQWF Source and Sink activities map to the BPEL Receive and Reply
activities.

2) How the WMQWF data flow is mapped to the BPEL Assign activity.
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Mapping FDL control flow to BPEL “Flow”
WebSphere MQ Workflow Business Process Choreographer
= M.m,‘i, LR [} M\/Em:tw\cnv\ty
MyBlockact M A
oSN y mpT}/ i E MyBlockActivity E MyEmptyActivity
I = J
Ev- * ity
>l Flow | —=
= My)affActivi MyUPESActivity
m & MyUPESActV ity
MyStaffactivity MyUPESActivity i
26

WebSphere MQ Workflow Migration

The generalized WMQWEF on the left will be used to illustrate the WMQWF to BPEL
mappings. With WMQWEF, the concept of multiple concurrent threads is inherent in the
model. The multiple paths converge on an activity, which is responsible for
synchronizing and distributing the data. There is no special kind of activity.

© 2005 IBM Corporation

In BPEL, concurrent execution is modeled with a Flow activity, which is special kind of
activity designed to manage and organize the concurrent paths. The contents of the
flow can be hidden by collapsing the icon (-) and viewed by expanding it again (+)

The graphic illustrates:
1) The mapping of the entire WMQWF model to a BPEL Flow

2) Expanding the BPEL Flow activity you can see the boundary of the flow is defined by
the horizontal blue bars at the top and the bottom. The purple lines represent the links
from one activity to the next, the concurrent paths of execution. Notice too, that each
activity is also encapsulated by the BPEL Sequence activity, which is another
organizing structure.

3) The expansion of the Sequence activities, revealing the details of the activities.
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Mapping FDL data connector to BPEL “Assign activity”

WebSphere MQ Workflow Business Process Choreographer

- = MyBlockActivity = MyEmptyActivity

1 T
My BlockActiity My ErmplyActivity B Mme\c‘;essActiww
- L& WPrasasarcidty L = .
- g ~
S ——— N
4 \
\

- -~
/\ = "MyProcessActivity_OUT" -> "MyStaffactivity_IN" h) \
- -—

—_— e == — ]

e
o T \ ——— -—-—

T “MyProcgssActivity =l Wﬂijw‘ -> "MyUPESACHvity y’ﬁ
| ____‘_,_‘/—
—o_ V'—L\',
E = MySﬁActwmf = MyUPSActMty
MyStatfactivity MyUPESctivity - -

WebSphere MQ Workflow Migration

In this example, the “MyProcessActivity” has data that must be distributed to 2 different
outputs. In WMQWF the data connectors provide the mechanism for achieving this. In
BPEL there are no data connectors, so the solution is to insert a BPEL Flow in the
BPEL Sequence called “MyProcessActivity” directly after the Invoke activity. The data
assignments are then made in the context of the Flow, one for each possible output
(data connector).

© 2005 IBM Corporation

The red circles highlight the area of interest in the graphic shown here, which illustrates:

1) The data connectors on the WMQWF side and the insertion of the sequence on the
BPEL side.

2) The mapping of the data connectors to the Assign activities in the BPEL Sequence.
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Mapping FDL process activity to BPEL “invoke activity”

WebSphere MQ Workflow

Business Process Choreographer

oK Cancel | Apply | Beset

M}\Ea Objectlacked by user ID ADMIN [Ed Diagram storage made

= MyBlockActivity

[

£ MyEmptyActivity

= NS
5 MDessmms Ambiveibn

mpmh\ems | Servers ‘ Sear[h|

W & MyProcessActivity

Implementation Partrer: Travelbooking_PL

Compensation Interface: Travebooking_PT

Expiration COperation: | Travelbooking_OF

Documentation [ Use Data Type Variables

Join Behaviar Request: MyProcess_hyProcessActivity_ I
Correlation | Resporse:  MyProcess MyProcessActvity OUT
Event Monitor

Server

Human Task

WebSphere MQ Workflow Migration
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Mapping the WMQWEF activity to the BPEL Invoke activity is straightforward.

Remember that with WMQWF, the kind, or behavior of an activity is defined by the
properties. The property panels for both the WMQWF and the BPEL are shown to
illustrate how the details are mapped from one to the other. Notice that the name of the
WMQWEF activity, which is a process, is mapped to an operation on a Web Service in

the BPEL implementation.
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Mapping FDL block to BPEL “Scope”

WebSphere MQ Workflow Business Process Choreographer
—
l Z MyBlockActivity g
N Z MyBlockActivi 2 MyEmptyActivi
MyBIo@RA/cT ity i g ' ty "
. - T~

""" - T ’ S
[ T MyBlockctity
N

1
1

/
1
' / I S _-"
! g R .
1 1
e = lesc At I 2 MyBlockhctivty
m e gy
1 B c 1

1

A :

e o e o - - [ | 1 i !
/4 o ﬁ‘ﬁ ;

1

:

1

mag| =g 2 MyStafftd
[FP] 3 !
MyStatfactivity MyUPESActivity '

WebSphere MQ Workflow Migration © 2005 IBM Corporation

The concept of Block and Scope are identical. They both provide a mechanism to create a
local boundary, which is used to create a local context for isolating local variables and
associating units of work and error handling constructs. They are also used to organize
and hide the complexity.

In the graphic shown:

1) The red circles highlight the area of interest.
2) The WMQWF Block and BPEL scope are expanded to reveal the details.
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Mapping FDL empty activity to BPEL “empty activity”

WebSphere MQ Workilow Business Process Choreographer
1 \
\ e y .
iy BlockActhyity Py mpT)'/A/ctiviTy ” &y § MyEmetyActmty
/’——_~\
\ [ MyEmptyActivity /\
~ ~ e - -
W
2 MyProcesshctivity
i
W W
ma 1| = MyStaffactivity = MyUPESActivity
v ]

MyStatfactivity MyUPESActivity

WebSphere MQ Workflow Migration © 2005 IBM Corporation

There is a direct mapping of the Empty Activity from WMQWF to BPEL. To determine if
the WMQWEF Activity is truly an Empty activity there are properties that must be

interrogated first. The application of the classification rules will be discussed in the next
few slides.

In the graphic shown:
1) The red circles highlight the areas of interest.
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Classification Rules

= WMQWEF defines a generalized activity distinguished by
the values of it’s properties.

» The properties determine the class, and thus the behavior, of the
activity.
= BPEL defines specific kinds of activities such as
» Invoke, Human Task and Empty

= To m%from WMQWF to BPEL, the properties of the

WMQWEF activity are used to determine which kind of
BPEL activity to map to.

> Thdere are 3 classification rules which are checked in sequential

order.

1. Empty activity
2. Service Invocation activity
3. Staff activity

» If none of the rules apply then a warning message issued.

WebSphere MQ Workflow Migration © 2005 IBM Corporation

The WMQWEF activities are defined using properties whereas with BPEL there distinct
kinds of activities, such as Human Task (Staff), Empty or Service Invocation. To determine
which kind of BPEL activity to map the WMQWF activity to, the properties must be
inspected and the classification rules applied.
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Classification Rule 1: BPEL “empty activity”

2 MyEmptyActivity - Progrd E= MyEmptyActivity - Program ac|
sz | Noific Safiz | MNofiication
General | Execuion | General | Execuion | stan
Name [y Empyacts —Execution Urit

™ User program execution age

Program execufion server——
Descriptian  Sener l—
& From container  [dummy
TN = MyEmptyActivi
o — ~ , " Synchronous ' y _pty ty
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Classification Rule 1:
This is the first rule that is checked.

The migration utility will inspect the properties associated with the “Program Activity” and if
it is defined to be a no-operation (NOOP) type of activity, which is asynchronous, and
there is no change in the data, the activity is mapped to the Empty BPEL activity.

All three conditions must be met.

In other words, If “FMINTERNALNOOP” and “asynchronous” and “Input=Qutput” then
Activity is of type “Empty”
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Mapping FDL UPES activity to BPEL “service invocation activity”

WebSphere MQ Workflow Business Process Choreographer
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The WMQWEF UPES activity is mapped to BPEL Invoke activity. The program executed by
the UPES becomes the implementation for a Web Service invocation from BPEL.

The Migration Wizard will create the corresponding Invoke activity for the UPES but there
is no support for creating the Web Service implementation. There is no UPES
compatibility layer provided at this time.

In the graphic shown:

1) The red circles highlight the areas of interest
2) The details of the activity definitions are displayed for comparison.

WPSWIDv6_MQWF_Migration.ppt Page 33 of 54



| IBM Software Group

Classification Rule 2: BPEL “Service invocation activity”
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Classification Rule 2:
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If the execution mode of the WMQWF “Program Activity” is configured to be a server, then

the activity is mapped to a BPEL Invoke Activity.
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Message flow: BPC invokes UPES
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This illustrates the message flow involved with invoking a UPES from Business Process
Choreographer.

The implementation of MyUPESActivity (BPEL) is responsible for marshalling the
message and calling the UPES.

In the WPS V6.0.1 Information Center, this is referred to as the UPES compatibility layer.
The UPES compatibility layer is not provided with WMQWF and must be developed by
integration developers.
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Adding UPES message types to XMLSchema definitions

WebSphere MQ Workflow Business Process Choreographer
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The UPES message types will be converted to XML Schema
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Encoding UPES input
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BPEL Assignment activities will be inserted to copy the data to/from the BPEL variables
and the UPES Business data and context.
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Mapping FDL staff assignment to “Inline Human Task”

WebSphere MQ Workflow Business Process Choreographer
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The WPS BPEL extension for the Human Task is a direct analog for the WMQWF Staff
activity.

© 2005 IBM Corporation

The inline Human Task activity provides strong integration capabilities between the
business process and the human task but is not BPEL 2.0 compliant.

In the graphic shown:

1) The red circles highlight the areas of interest.

2) The WMQWF Staff becomes an inline Human Task.

3) The details of the two activities are displayed for comparison.
)

4) The Human Task is further expanded to show the association of the groups and
people permitted to interact with the task.
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Classification Rule 3: BPEL “Staff activity”
)
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The third classification rule checks the properties of the WMQWF “Program Activity” to
determine if it has been configured to be checked out and requires manual intervention. If
this is the case, then the appropriate corresponding BPEL activity will be an inline Human
Task activity.
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Limitations

40

WebSphere MQ Workflow Migration © 2005 IBM Corporation

When mapping from one programming model to another, different programming model
there will always be some features that are new, different or missing and therefore require
manual intervention.

The mismatch between the WMQWF model and the WPS V6 SCA programming model is
captured here in the form of limitations. Knowing the limitations and discontinuities ahead

of time is extremely valuable in determining the amount of effort required to complete the

migration.
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WMQWEF Migration limitations (1)

= BPEL has no equivalent activity type with a
similar semantic as the FDL "program activity"

construct.

= Explanation: BPEL does not let you combine the
invocation of a program application with the
assignment of a work item to a user.

= You may want to modify the generated BPEL files
and insert additional ,inline human tasks® or
~nvoke* activities according to your requirements.

a
© 2005 IBM Corporation

WebSphere MQ Workflow Migration

*The FDL concept of a ,program activity® means that the ,program execution agent* (PEA)
executes the application on the workstation of the user who claimed the respective
workitem. With BPEL you cannot specify the location of the program execution as the
location of the user.

*You could insert additional synchronization points with user interaction. For example
you could insert an ,inline human task® that precedes an ,invoke* activity so that the user
can decide when the respective service is allowed to execute.
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WMQWF Migration limitations (2)

= WPS does not support UPES invocation!

| Hint [

1. Use WebSphere Integration Developer to
turn the temporary “staff activities” / “empty
activities” into “invoke” activities with an
appropriate Java implementation.

2. Use WMQWF Buildtime to turn “UPES
activities” into temporary “staff activities” or
“empty activities” according to the above

mentioned activity classification rules.

Rty A

WPS does not yet support UPES invocation.

WebSphere MQ Workflow Migration © 2005 IBM Corporation
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WMQWF Migration limitations (3)

= The BPEL condition logic is dual-value logic as
opposed to the ternary logic used in WMQWEF.

— L Him [

MQWEF migration handles this discrepancy as follows:

1. Data mappings that refer to unset source data
members are ignored.

2. Conditions that refer to unset source data members
are evaluated as "false".

WebSphere MQ Workflow Migration © 2005 IBM Corporation

The BPEL condition logic is dual-value logic as opposed to the ternary logic used in
WMQWEF.
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WMQWEF Migration limitations (4)

= MQWF migration cannot map all staff queries
that you specified for a WMQWF process or its
contained program activities.

| Hint [

= You may have to replace some of the generated
staff verbs by user-defined staff verbs if you need
to have complex query logic.

WebSphere MQ Workflow Migration © 2005 IBM Corporation

MQWF migration cannot map all staff queries that you specified for a WMQWF process or
its contained program activities.
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WMQWEF Migration limitations (5)

= Some error and warning messages may not give
you enough context information to understand
the problem (i.e. "lllegal data path expression™).

Y —

= In such cases it is helpful to locate the same
message in the generated files using a source
editor (usually the files with extension "*.bpel").

WebSphere MQ Workflow Migration © 2005 IBM Corporation

While FDL2BPEL generates the target constructs, the context of a problem situation is
sometimes unknown, and the appropriate information is not available to give a clear
explanation. But the error message will always be inserted as a comment annotation at the
respective location in the generated BPEL or WSDL file where the problem occurred. So,
usually finding the same message in the file will help to understand the problem. For
instance, the above message "lllegal data path expression" might be found in a condition
expression that refers to an undefined data member in the input variable of an activity.
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WMQWEF Migration limitations (6)

= The activity state "_Expired" in a condition
expression cannot be appropriately mapped.

— L Hint |

= Explanation: Business Process Choreographer throws
an exception in case of expiration.

= You may add a fault handler to the generated BPEL
process in order to catch the "_Expired" state.

WebSphere MQ Workflow Migration © 2005 IBM Corporation

The activity state "_Expired" in a condition expression cannot be appropriately mapped.
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WMQWEF Migration limitations (7)

= The generated BPEL files do not always represent
the most compact translation of a given WMQWF

process.

= Explanation: MQWF migration applies a translation
pattern that preserves the original process topology.

= You may want to do some reworking of the generated
BPEL file in order to improve it.

WebSphere MQ Workflow Migration © 2005 IBM Corporation

For instance, a data connector that passes data unchanged from one activity to another
might sometimes be better mapped to a shared BPEL variable where the FDL2BPEL
conversion tool generates two BPEL variables and an "assign" activity that does the data

mapping.
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WMQWEF Migration limitations (8)

= The input / output data of a FDL process activity and
input / output data of the respective sub process
must be the same before you can convert to BPEL.

Y —

= Explanation: Other than FDL the BPEL specification
does not allow a “subset” or “superset” relationship
between data passed from one process to another.

= |If you need such a combination you should modify the
FDL model before migration or insert “assign” activities
with data mapping instructions to the BPEL model after
migration.

WebSphere MQ Workflow Migration © 2005 IBM Corporation

The input / output data of a FDL process activity and input / output data of the respective

sub process must be the same before you can convert to BPEL.
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WMQWEF Migration limitations (9)

= BPEL does not support predefined data that are
equivalent to the FDL predefined data members.

— ] mint |

= Nonetheless WMQWF migration converts FDL data
structures to corresponding message types that
include the predefined data members like _RC,
_ACTIVITY_INFO, etc.

= You may run WMQWF migration with an option that
requests the initialization of the predefined data
members _ACTIVITY, PROCESS, and
_PROCESS_MODEL.

WebSphere MQ Workflow Migration © 2005 IBM Corporation

Business Process Choreographer does not offer support for setting predefined data
members.
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WMQWEF Migration limitations (10)

= Not all properties that you can specify in FDL have
a corresponding BPEL notion.

— L Him [

= Respective warnings in the FDL2BPEL output will
inform you about such limitations.

WebSphere MQ Workflow Migration © 2005 IBM Corporation

The concept of a ,global container” is not yet supported in BPEL. Nevertheless, the
WMQWF migration generates a BPEL variable for it.
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WMQWEF Migration limitations (11)

= Migration does not work properly with FDL input
files containing a version ID prior to
"FM_RELEASE V3R6"

— ] mint |

= Migrate the FDL file using MQ Workflow Buildtime
with V3.6 or later before you run the FDL to BPEL
migration.

WebSphere MQ Workflow Migration © 2005 IBM Corporation

The concept of a ,global container” is not yet supported in BPEL. Nevertheless, the
WMQWF migration generates a BPEL variable for it.
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References

= WA73 Support Pak

» http://www-
1.ibm.com/support/docview.wss?rs=171&uid=swg240083
62&loc=en_US&cs=utf-8&lang=en

WebSphere MQ Workflow Migration © 2005 IBM Corporation

The WA73 support pak contains the FDL2BPEL utility and documentation.
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Summary
= Migrating from WMQWF to BPEL / SCA is not a perfect fit.

» There is post migration work involved.

= The process is one of
» Export from WMQWF

» Import to WebSphere Integration Developer
= Migration wizard
= Import
= FDL2BPEL + Import

» Tune the new model for BPEL/SCA

» Deploy to the WPS runtime

= What can be mapped is well defined

= There are some WMQWF features that are not migrated to
BPEL/SCA and this is captured in the Limitations section.

WebSphere MQ Workflow Migration © 2005 IBM Corporation

To summarize, depending on the complexity of the WMQWF application there will be
some post migration work involved.

The basic process is to export the application from the source system, import to the target
system, edit, resolve errors and tune the application for BPEL / SCA and deploy the
application to the WPS V6 runtime.

When importing the WMQWF FDL into WID, there are several options available, the
Migration Wizard, Import or FDL2BPEL + Import.

Using FDL2BPEL + Import provides more control and flexibility over the process and is
useful for debugging problematic migrations.
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